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Excel	dashboards	are	an	effective	way	to	visualize	data,	track	key	performance	indicators	(KPIs),	and	provide	insights	in	a	single	view.	With	interactive	elements	like	slicers,	charts,	and	PivotTables,	Excel	dashboards	enable	real-time	data	exploration.	This	guide	will	walk	you	through	creating	a	dynamic,	interactive	dashboard	in	Excel	to	streamline
your	data	analysis.	1.	Planning	Your	Dashboard	LayoutBefore	building	a	dashboard,	its	essential	to	plan	the	layout.	Decide	which	KPIs,	charts,	and	metrics	you	want	to	include,	and	ensure	that	the	data	sources	are	well-structured	and	accessible.Key	Components	of	an	Excel	DashboardData	Source:	Prepare	a	structured	dataset,	ideally	in	table	format,
to	make	updates	and	filtering	easier.	Charts	and	Tables:	Use	a	mix	of	PivotTables,	Pivot	Charts,	and	regular	charts	to	display	key	metrics.	Interactive	Elements:	Add	slicers,	timelines,	and	drop-downs	to	filter	data	dynamically.	Consistent	Layout:	Arrange	charts,	metrics,	and	interactive	elements	in	a	logical	flow.Related	Guide:	Learn	about	Organizing
Data	Efficiently	in	Excel	to	get	your	data	ready	for	dashboards.	2.	Setting	Up	Your	Data	TableConvert	your	dataset	into	an	Excel	Table	for	easy	filtering	and	automatic	range	adjustments	when	data	is	updated.	How	to	Create	a	TableSelect	your	dataset,	including	headers.	Go	to	Insert	>	Table	or	press	Ctrl	+	T.	Confirm	that	My	table	has	headers	is
checked,	then	click	OK.	In	MyBudgetSystem,	I	use	this	same	setup	to	manage	budgeting	categories,	expenses,	and	monthly	cash	flowall	structured	in	clean	Excel	tables.	3.	Creating	PivotTables	and	PivotChartsPivotTables	and	PivotCharts	are	essential	for	summarizing	data	in	dashboards,	allowing	you	to	drill	down	into	specifics	or	view	aggregate
data.How	to	Create	a	PivotTableSelect	any	cell	in	your	data	table.	Go	to	Insert	>	PivotTable.	Place	the	PivotTable	on	a	new	worksheet	and	choose	fields	to	analyze.How	to	Add	a	PivotChartClick	within	the	PivotTable.	Go	to	PivotTable	Analyze	>	PivotChart.	Select	a	chart	type,	such	as	column	or	line,	and	click	OK.Explore	More:	Check	out	our	Guide	to
Using	PivotTables.	4.	Adding	Slicers	for	Interactive	FilteringSlicers	are	visual	filter	controls	that	make	your	dashboard	interactive,	enabling	users	to	explore	data	by	specific	categories,	like	region	or	product	type.How	to	Add	SlicersSelect	your	PivotTable	or	PivotChart.	Go	to	PivotTable	Analyze	>	Insert	Slicer.	Choose	the	fields	you	want	to	filter	by
and	click	OK.	Resize	and	arrange	the	slicers	on	your	dashboard	for	easy	access.	5.	Incorporating	Timelines	for	Date-Based	FilteringTimelines	are	similar	to	slicers	but	are	specifically	designed	for	filtering	data	by	date,	making	them	ideal	for	tracking	data	trends	over	time.How	to	Add	a	TimelineSelect	your	PivotTable.	Go	to	PivotTable	Analyze	>	Insert
Timeline.	Choose	a	date	field,	then	click	OK.Example:	Use	a	timeline	to	view	monthly,	quarterly,	or	yearly	sales	trends.	6.	Designing	Chart	Layouts	and	StylesExcel	offers	several	chart	styles	and	layout	options	to	enhance	the	visual	appeal	of	your	dashboard.	Customize	each	chart	to	ensure	consistency	and	readability.Key	Customization	OptionsColors:
Use	a	cohesive	color	scheme	across	all	charts.	Data	Labels:	Display	data	labels	to	highlight	specific	values.	Axis	Titles	and	Chart	Titles:	Clearly	label	each	chart	to	avoid	confusion.	7.	Adding	Drop-Down	Lists	with	Data	ValidationDrop-down	lists	allow	users	to	select	specific	metrics	or	categories	for	analysis,	giving	your	dashboard	greater
flexibility.How	to	Create	a	Drop-Down	ListGo	to	the	cell	where	you	want	the	drop-down	list.	Go	to	Data	>	Data	Validation.	In	the	Allow	dropdown,	choose	List	and	enter	the	list	options	or	link	to	a	range.	Ive	used	this	exact	setup	inside	MyBudgetSystem	to	let	users	toggle	between	categories	like	Food,	Housing,	or	Debt	and	instantly	update	their
monthly	view.	8.	Assembling	and	Organizing	Your	Dashboard	ElementsOnce	your	charts,	slicers,	and	drop-down	lists	are	ready,	organize	them	into	a	cohesive	layout	on	a	single	sheet.Tips	for	Effective	LayoutGroup	Related	Metrics	Align	and	Resize	Elements	Minimize	ScrollingPro	Tip:	Use	cell	borders	and	shading	to	define	sections	and	create	a
visually	pleasing	layout.	9.	Updating	Your	Dashboard	AutomaticallyIf	your	data	changes	frequently,	youll	want	to	set	up	automatic	refresh	options	to	keep	your	dashboard	up-to-date.How	to	Refresh	Dashboard	DataGo	to	Data	>	Refresh	All	to	update	all	tables	and	PivotTables.	Alternatively,	use	Ctrl	+	Alt	+	F5	to	refresh	data.	Best	Practices	for
Building	DashboardsKeep	It	Simple	Use	Consistent	Colors	and	Fonts	Provide	Clear	Labels	Test	Interactivity	One	of	the	most	effective	dashboards	Ive	built	is	actually	inside	BridgeBudgetthe	mobile	interface	functions	like	a	personal	finance	dashboard,	showing	income,	spending,	and	goals	all	in	one	place.	ConclusionCreating	an	interactive	dashboard
in	Excel	allows	you	to	consolidate	key	metrics,	visualize	data	trends,	and	provide	a	dynamic,	user-friendly	experience.	If	you	want	to	see	real-world	applications	of	Excel-style	dashboards	in	personal	finance,	explore	MyBudgetSystem	for	spreadsheet-based	tools,	or	try	BridgeBudget	for	a	clean,	visual	app	experience	that	mirrors	the	best	parts	of
Excelwithout	needing	to	open	a	file.Next	Steps:	For	more	advanced	options,	check	out	our	Guide	to	Power	BI	Dashboards.Data	analysis	can	help	you	improve	your	processes	with	efficient	reporting	methods.	But	sometimes,	you	need	more	than	just	numbers	in	a	spreadsheet	to	make	your	point.	So,	why	not	use	data	visualization	tools	like	interactive
dashboards?	They	can	help	report	campaigns,	increase	conversions,	analytics,	and	more.	In	this	article,	we'll	walk	through	how	to	create	an	interactive	dashboard	with	an	example	and	also	provide	tips	for	designing	beautiful	dashboards	in	Excel.	1.	Organize	Your	Source	Data	and	Create	a	Layout	A	well-designed	dashboard	is	a	powerful	reporting	tool
that	can	help	you	visualize	and	communicate	your	data.	The	first	step	is	ensuring	that	your	data	is	free	of	errors	and	properly	organized	into	rows	and	columns	with	appropriate	headers.	You	can	use	dashboards	in	any	industry,	but	they're	especially	helpful	in	finance,	sales,	and	marketing.	When	designing	a	dashboard,	you	should	remember	that	it
should	be	easy	for	end	users	to	navigate.	The	next	step	is	to	decide	the	kind	of	layout	based	on	the	information	that	needs	to	be	displayed.	For	our	example,	let's	create	a	dashboard	that	shows	the	following	information	on	one	sheet:	Cells	A3	-	T5:	Project	Status	Cells	A7-T16:	Overview	and	Project	Financials.	Cells	A15-	U25:	Project	Progress	and	Heat
map.	Create	a	new	Excel	worksheet	labeled	"Dashboard".	This	is	where	you'll	build	up	your	dashboard	by	adding	elements.	Using	text	styles	and	fonts	that	align	with	your	or	your	brand's	voice,	tone,	and	personality	is	also	a	good	idea.	A	pivot	table	makes	it	easy	to	organize	your	data	in	Excel	into	groups.	You	can	use	the	tool	to	count,	sum	up,	multiply
values,	and	perform	multiple	actions	across	those	groups.	To	demonstrate	how	these	interactive	dashboards	actually	work,	we'll	create	an	interactive	"Freelance	Projects"	dashboard	as	an	example.	You'll	need	to	arrange	your	data	in	a	tabular	format.	To	do	this,	use	the	keyboard	shortcut	CTRL	+	T	and	select	the	data.	For	this	purpose,	our	source
data	will	look	somewhat	like	this:	Once	done,	open	a	new	worksheet	and	label	it	as	PivotTable.	Within	the	worksheet,	we'll	create	a	Pivot	table	by	going	to	the	Insert	option	on	the	ribbon.	Select	the	data	range	for	your	table.	Now,	it's	time	to	choose	the	fields	for	your	Pivot	table.	Following	our	example	above,	select	the	fieldsTask,	Manager	name,
Project	start	and	end	dates,	Duration,	Days	to	completion,	Progress,	etc.	for	your	row	labels.	For	the	column	labels,	assign	budgeted	and	actual	values	Once	the	data	shows	up	in	your	worksheet,	arrange	the	same	in	a	tabular	format.	To	do	this,	go	to	the	layout	section	in	Design	>	Report	Layout,	and	select	Show	in	Tabular	Form	from	the	drop-down
options.	Ungroup	the	data	by	right-clicking	on	the	data	fields.	You'll	also	need	to	turn	off	the	sub-totals.	To	do	so,	head	over	to	the	Design	Tab	>	Subtotals	>	Do	Not	Show	Subtotals.	Now,	your	PivotTable	would	look	like	this:	To	choose	a	PivotTable	color,	go	to	the	Design	Tab	>	PivotTable	Styles.	Turn	off	collapsible	headers	by	going	to	PivotTable
Analyze	>	Show	(extreme	right	corner).	Turn	off	the	+/-	Buttons.	To	organize	your	data	further,	go	to	Design	>	Report	Layout	>	Repeat	All	Item	Labels.	It's	crucial	to	ensure	that	you're	using	the	correct	formulae,	or	else	your	data	will	be	inaccurate	and	misleading.	For	our	example,	let's	start	by	counting	the	number	of	projects	across	different
categoriesstarted,	work-in-progress,	or	completed.	To	do	this,	we'll	need	to	use	the	COUNTIF	and	COUNTIFS	functions.	Create	a	new	"Calculations"	worksheet	for	working	with	formulae	and	charts	while	building	your	dashboard.	Enter	the	status	of	projects	("Work-in-progress",	"Active	Projects	Remaining",	"Completed	Before	Due	Date",	and
"Completed")	in	consecutive	rows,	as	shown	below.	Next,	select	the	Progress	(%)	column	in	your	Pivot	Table.	The	total	number	of	tasks	works	out	to	be	32.	Using	the	COUNTIF(S)	function(s),	you	can	calculate	the	number	of	projects	categorized	under	the	subheadings	as	follows.	Depending	on	the	nature	of	projects	you're	using	filters	for,	make	sure
to	include	the	appropriate	data	columns	in	your	Pivot	Table	worksheetfor	active	projects,	it	makes	sense	to	use	the	Progress	column,	whereas	for	canceled	projects,	use	the	Cancelled	column.	With	the	help	of	the	appropriate	formulae	and	visual	formatting,	you	can	create	meaningful	charts	or	graphs	that	help	you	better	understand	your	data.	In	this
example,	let's	try	to	add	a	chart	for	completed	projects;	follow	the	steps	listed	below:	In	your	Calculations	sheet,	look	at	cell	B7	as	shown	above.	To	plot	your	chart,	start	by	selecting	cells	D7	and	E7.	Next,	go	to	Insert	>	All	Charts	>	Sunburst	or	Donut	chart.	Once	the	chart	comes	up,	click	on	the	plus	(+)	symbol	on	the	right	to	access	formatting
options.	Choose	Chart	Elements	as	you	wish	to.	Click	on	different	parts	of	the	chart	to	bring	up	formatting	options	such	as	Format	data	series,	plot	area,	etc.	Using	these;	you	can	easily	customize	the	colors,	titles,	borders,	and	other	attributes	for	your	chart.	Once	this	is	done,	you	can	copy	and	paste	the	chart	onto	the	top	of	your	dashboard	and	align
it	accordingly.	For	the	other	rows,	select	the	desired	data	in	the	Calculations	sheet	and	repeat	the	process	above	for	any	other	charts	or	graphs	you	wish	to	include.	You	can	easily	add	elements	such	as	heatmaps,	icons,	slicers,	and	scroll	bars	to	your	dashboard	to	make	it	more	interesting,	informative,	and	engaging	for	your	audience.	Let's	take	a
closer	look	at	some	of	them.	Insert	Slicers	for	Interactivity	Slicers	are	short	tabs	that	allow	you	to	filter	the	data	on	your	dashboard	in	real-time.	Here's	how	to	add	them	to	your	dashboard:	Select	the	cells	that	contain	your	data.	Navigate	to	the	Insert	tab	>	Filters	>	Slicer.	Choose	the	type	of	slicer	you	want	from	the	drop-down	menu,	then	click	OK.	To
align	them	horizontally,	click	on	the	Buttons	section	in	a	separate	Slicer	tab.	You	can	also	leave	them	as	is,	depending	on	how	you	want	your	dashboard	to	look.	For	our	dashboard,	we'll	add	slicers	for	the	headingsManagers	and	Projects.	Here's	how	to	do	this:	Select	the	data	in	your	Calculations	sheet	and	select	these	options	from	the	drop-down
menu.	Next,	you'll	need	to	link	slicers	to	your	Pivot	tables.	To	do	this,	right-click	on	the	slicer,	and	click	Report	Connections.	In	the	dialog	box	that	appears,	select	all	the	PivotTables	and	Pivot	charts	and	click	OK.	Scroll	bars	allow	you	to	view	updated	data,	which	is	helpful	if	you're	looking	at	something	that's	changing	over	time.	To	add	a	scroll	bar,	go
to	the	Developer	tab.	Keep	in	mind	that	this	option	isn't	enabled	by	default.	To	activate	the	Developer	tab,	go	to	File	>	Options	>	Customize	Ribbon.	Under	the	Main	tab,	check	the	Developer	box.	To	insert	the	scroll	bar,	go	to	the	Developer	tab	>	Insert	>	Form	controls.	Hover	the	mouse	over	the	options	and	select	the	Scroll	bar.	Drag	it	and	place	it	in
the	row	or	column	of	your	choice	in	your	Dashboard	Add	a	Quick	(Project)	Overview	Tab	To	get	a	quick	view	of	project	details,	you	can	import	the	data	from	the	Pivot	Table	into	your	dashboard.	We'll	be	using	the	INDEX	function,	as	shown	below.	Our	data	array	consists	of	cells	B8	through	K40	in	the	Pivot	Table	Tab.	To	bring	up	the	data	from	our
pivot	table,	we'll	input	the	function:	=INDEX('Pivot	Tables'!$B$8:$K$40,'Pivot	Tables'!$B$6	+	ROWS(Dashboard!$A$13:F17)-1,COLUMNS(Dashboard!$A$13:F17))	Now,	our	dashboard	looks	something	like	this:	Apply	Conditional	Formatting	Now	that	we've	created	a	quick	project	overview	tab,	you	might	want	to	highlight	project	update	percentages.
You	can	easily	use	conditional	formatting	to	apply	color	scales	or	data	bars	to	do	this.	This	will	allow	you	to	see	at	a	glance	which	projects	are	completed	and	which	ones	need	more	work.	Here,	we've	used	a	three-color	scale	to	highlight	the	progress	of	individual	projects,	as	shown	below:	Heatmaps	are	visualization	tools	that	can	be	useful	to	highlight
patterns	within	your	data.	For	example,	you	could	use	a	heatmap	to	show	the	number	of	times	visitors	clicked	on	different	parts	of	your	webpage.	First,	you'll	need	to	create	a	table	with	the	data	you	want	to	see	mapped	out.	In	our	example,	we've	calculated	the	project	count	between	two	dates	using	the	COUNTIFS	function,	as	shown	below.	You	can
use	conditional	formatting	to	apply	rules	to	different	parts	of	your	table.	The	completed	dashboard	would	look	like	this:	Excel	dashboards	are	a	great	way	to	visualize	data,	and	we	hope	this	guide	can	help	you	create	one	specific	to	your	needs.	Interactive	and	dynamic,	these	useful	tools	can	aid	decision-makers	in	a	quick	and	easy	analysis	of	relevant
data.	With	just	a	dash	or	two	of	creativity,	Excel	spreadsheets	can	go	far	beyond	the	norm,	and	you	can	create	something	truly	engaging	and	presentable.	Interactive	dashboards	are	powerful	tools	for	visualizing	and	analyzing	large	data	dynamically	in	Excel.	It	offers	a	dynamic	way	to	analyze	data	to	get	quick	insights.	Excels	Form	Controls	are	an
excellent	feature	for	creating	such	dashboards	without	VBA.	It	allows	users	to	interact	with	data	through	buttons,	sliders,	combo	boxes,	and	checkboxes.	In	this	article,	we	will	show	how	to	create	interactive	dashboards	with	form	controls	in	Excel.Consider	a	sales	dataset	to	show	the	necessary	Form	Controls	to	create	an	interactive	dashboard.Step	1:
Prepare	the	DatasetConvert	the	sales	data	into	an	Excel	table.	Select	the	data	range.Go	to	the	Insert	tab	>>	select	Table.Select	My	table	has	headers	>>	click	OK.Name	the	table	as	SalesData	for	better	readability.Excel	Table	offers	dynamic	ranges	for	formulas	and	charts.Step	2:	Insert	Form	Controls	and	Link	it	to	CellsBased	on	your	dataset	type,
you	can	select	relevant	Form	Controls.Option	Button	(to	filter	by	region):Go	to	the	Developer	tab	>>	from	Insert	>>	select	Option	Button.Place	the	Plus	icon	(+)	on	the	dashboard	area.Right-click	on	the	Option	Button	>>	select	Format	Control.In	the	Format	Object	dialog	box:Cell	link:	Select	cell	I1	to	store	the	selected	regions.Select	3-D	shading	>>
click	OK.Right-click	on	the	Option	Button	>>	select	Edit	Text	>>	insert	Regions	(e.g.,	North,	South,	East,	West)	one	by	one.Combo	Box	(to	filter	by	Product):Developer	Tab	Insert	Combo	Box.Place	it	on	the	dashboard	area.Go	to	the	Developer	tab	>>	from	Insert	>>	select	Combo	Box.Place	the	Plus	icon	(+)	on	the	dashboard	area.Right-click	on	the
Combo	Box	>>	select	Format	Control.In	the	Format	Object	dialog	box:Input	range:	Select	the	list	of	products	(e.g.,	Product	A,	Product	B,	Product	C,	Product	D).Cell	link:	Select	cell	J1	to	store	the	selected	products.Select	3-D	shading	>>	click	OK.Check	Boxes	(to	toggle	metrics	like	Revenue,	Units	Sold,	and	Profit):Go	to	the	Developer	tab	>>	from
Insert	>>	select	Check	Box.Place	the	Plus	icon	(+)	on	the	dashboard	area.Right-click	on	the	Check	Box	>>	select	Format	Control.In	the	Format	Object	dialog	box:Cell	link:	Select	cell	K1	to	store	the	selected	metrics.Select	3-D	shading	>>	click	OK.Right-click	on	the	Option	Button	>>	select	Edit	Text	>>	insert	metrics	name	(e.g.,	Revenue,	Units	Sold,
Profit)	one	by	one.Each	checkbox	returns	TRUE	or	FALSE	when	linked	to	a	cell	(e.g.,	K1,	K2,	K3	for	Revenue,	Units	Sold,	and	Profit,	respectively).Step	3:	Create	Dynamic	FormulasYou	can	use	dynamic	functions	to	link	the	sales	data	with	the	format	controls	to	make	the	dashboard	interactive.	We	are	going	to	use	the	FILTER,	SWITCH,	and	IF
functions	to	extract	data	based	on	form	selections	dynamically.Using	Dynamic	FILTER	FunctionFilter	Data	by	Region:Insert	the	following	formula	in	the	selected	cell	to	filter	sales	data	based	on	selected	regions.	=FILTER(SalesData,	SalesData[Region]	=	SWITCH(J1,	1,	"North",	2,	"South",	3,	"East",	4,	"West"))Filter	function	extracts	the	SalesData
table	to	display	the	rows	where	the	Region	matches	the	selected	value	in	cell	J1.The	SWITCH	function	translates	the	numeric	value	in	J1	(e.g.,	1,	2,	3,	or	4)	into	corresponding	region	names	(North,	South,	East,	or	West).	Only	matching	rows	are	included	in	the	result.Filter	Data	by	Product:Insert	the	following	formula	in	the	selected	cell	to	filter	sales
data	based	on	selected	products.	=FILTER(SalesData,	SalesData[Product]	=	SWITCH(K1,	1,	"Product	A",	2,	"Product	B",	3,	"Product	C",	4,	"Product	D"))This	formula	will	filter	the	sales	data	based	on	the	selection	of	combo	boxes.	We	selected	Product	A	from	the	combo	box	so	it	will	return	Product	As	sales	data.Filter	Data	by	Region	&	Product:Insert
the	following	formula	in	the	selected	cell	to	filter	sales	data	based	on	selected	regions	and	products.	=FILTER(SalesData,	(SalesData[Region]	=	SWITCH(J1,	1,	"North",	2,	"South",	3,	"East",	4,	"West"))	*	(SalesData[Product]	=	SWITCH(K1,	1,	"Product	A",	2,	"Product	B",	3,	"Product	C",	4,	"Product	D")))This	formula	will	filter	the	sales	data	based	on
the	selection	of	a	combo	box	and	option	button.	We	selected	the	South	region	and	Product	B.	Filter	function	will	return	only	the	sales	information	of	Product	B	from	the	South	region.Dynamic	Metric	DisplayYou	can	use	the	IF	function	to	display	the	sales	metrics	based	on	the	check	box	selection.Insert	the	following	conditional	logic	for	metrics	based
on	the	checkbox	values.	If	you	select	any	checkbox	it	returns	TRUE	otherwise	FALSE	in	the	linked	cell.	Based	on	the	value	of	the	linked	cell	the	IF	function	will	return	the	result.Revenue:Insert	the	following	formula	to	get	the	total	revenue.	=IF(L1,	SUM(SalesData4[Revenue	($)]),	"")To	get	the	totals	from	the	filtered	sales	data,	insert	the	following
formula:	These	formulas	will	sum	the	revenue	if	you	select	the	checkbox	of	Revenue.Profit:Insert	the	following	formula	to	get	the	total	profit.	=IF(M1,	SUM(SalesData4[Profit	($)]),	"")To	get	the	totals	from	the	filtered	sales	data,	insert	the	following	formula:	These	formulas	will	sum	the	profit	if	you	select	the	checkbox	of	Profit.Units	Sold:Insert	the
following	formula	to	get	the	total	units	sold.	=IF(N1,	SUM(SalesData4[Units	Sold]),	"")To	get	the	totals	from	the	filtered	sales	data,	insert	the	following	formula:	These	formulas	will	sum	the	total	units	if	you	select	the	checkbox	of	Units	Sold.Output:Step	4:	Insert	Dynamic	ChartsSelect	the	filtered	data.Go	to	the	Insert	tab	>>	click	on	All	Charts	>>
select	Column	chart.The	charts	will	update	automatically	based	on	the	Combo	Box	and	Option	Button.	This	chart	showing	the	sales	of	the	Product	A	in	the	North	region.Change	the	filter	option	to	see	the	dynamic	update	of	the	chart.	We	selected	East	region	and	Product	C.Step	5:	Customize	the	DashboardInsert	Shapes:Add	different	as	per	your
dashboard	requirements	to	separate	sections	like	filters,	charts,	and	metrics.Formatting:You	can	use	consistent	colors,	fonts,	and	styles.You	can	use	conditional	formatting	to	highlight.ConclusionWith	the	above	steps,	you	can	create	interactive	dashboards	with	form	controls	in	Excel.	We	have	shown	all	the	important	steps	by	creating	an	interactive,
visually	appealing	dashboard	using	a	large	dataset.	You	can	dynamically	filter	and	analyze	data,	making	it	a	powerful	tool	for	decision-making.	Do	not	forget	to	experiment	with	additional	features	of	form	controls.	Get	FREE	Advanced	Excel	Exercises	with	Solutions!	Lets	be	honest,	we	all	agree	Excel	is	an	old-school	talk!Yet,	with	over	1.1	Billion	users
globally,	it	still	holds	the	ground	when	it	comes	to	data	management	and	visualizations.	.	In	this	guide,	youll	discover:1.	Why	interactive	dashboards	supercharge	your	reporting	2.	Exactly	how	to	build	one	from	raw	data	to	live	visuals	3.	5	free	templates	to	kickstart	your	own	dashboard	4.	Pro	tips	to	overcome	Excels	limitations	Cant	wait	for	that	long?
Heres	a	quick	summary	of	the	article:An	interactive	dashboard	in	Excel	is	a	type	of	dashboard	where	you	can	track	KPIs	and	metrics	with	your	team,	change	data	as	per	your	business	KPIs	fluctuate,	and	track	changes	in	real-time.To	create	an	interactive	dashboard	in	Excel,	you	first	need	to	create	interactive	charts.	To	do	so,	you	first	have	to	convert
your	data	into	a	Pivot	table.These	pivot	tables	will	then	be	used	to	create	interactive	charts	which	will	then	go	on	the	Excel	dashboard.Creating	an	interactive	dashboard	in	Excel	is	tough	and	has	limitations.	Its	not	scalable,	has	limited	data	visualization,	and	doesnt	have	a	high	level	of	security.	To	overcome	all	these	challenges,	we	built
Datapad.Datapad	is	a	dashboarding	solution	to	create	interactive	dashboards,	bring	your	team	onboard,	and	track	KPIs	from	anywhere	in	the	world	from	your	mobile	device.Lets	transform	your	spreadsheets	into	dynamic,	interactive	reports!What	Is	an	Interactive	Dashboard	in	Excel?An	interactive	dashboard	in	Microsoft	Excel	is	a	one-pager	(mostly,
but	not	always)	report	that	allows	business	teams	to	track	and	measure	crucial	business	KPIs	and	metrics	under	one	roof.It	consists	of	a	combination	of	charts,	figures,	and	tables	that	visualize	complex	and	hard-to-understand	data	in	an	easy-to-read	format.Besides,	creating	an	interactive	dashboard	in	Excel	is	fun.	You	get	to	learn	most	of	the	Excel
functionalities	and	meanwhile	have	an	opportunity	to	create	something	stunning,	which	would	make	your	stakeholders	go	wow	for	the	job!	So,	are	you	ready?Lets	rightaway	jump	to	the	section	where	well	see	how	to	make	an	interactive	dashboard	in	Excel.How	to	Create	an	Interactive	Dashboard	in	Excel?	A	Step-By-Step	TutorialSteps	#1.	Define	the
Purpose	of	Your	DashboardBefore	starting	the	process,	let	us	ask:	Why	are	you	creating	this	dashboard	and	for	whom?Different	stakeholders	or	departments	within	the	organization	would	want	to	analyze	different	facts	and	figures.For	instance,	a	Chief	Financial	Officer	(CFO)	would	prefer	looking	at	key	financial	metrics,	while	an	investor	would	want
a	summarized	dashboard	of	all	the	departments.Keeping	this	in	mind,	try	to	attach	a	purpose	to	your	dashboard	and	then	collect	data	around	it	for	accurate	and	effective	decision-making.Step	#2:	Source	In	Data	and	Create	a	Pivot	TableHeres	a	raw	data	set	we	will	be	using	to	create	an	interactive	dashboard	in	Excel.Lets	first	convert	this	dataset	into
a	table	(you	can	skip	this	if	you	already	have	a	table).Select	your	data,	go	to	Insert	>	Table.	In	the	pop-up	that	opens,	tick	the	box	-	My	table	has	headers,	and	click	OK.Your	table	will	look	something	like	this:Next,	convert	the	table	into	Pivot	table;	this	will	help	you	create	interactive	charts	to	put	in	your	dashboard	in	Excel.	Select	the	table,	go	to
Insert	Tab	>	Pivot	Table.	Click	on	OK	and	you	will	have	a	new	sheet	with	Pivot	Table.For	our	interactive	Excel	dashboard	we	want	3	charts,	meaning	we	need	3	pivot	tables.	To	do	so,	we	will	just	duplicate	the	pivot	table	sheet	in	the	Excel	workbook.And	just	like	that	you	have	3	pivot	tables	ready.	Lets	move	on	to	the	next	step	to	create	charts	for	our
interactive	dashboard.Step	#3:	Create	Charts	with	Pivot	TableSo	our	first	chart	would	represent	every	products	monthly-wise	sale.For	that	we	need	3	data	entries	-	Sales,	Product,	and	Month.In	the	Pivot	table	sheet,	drag	and	drop	the	Month	data	in	the	rows	area,	product	in	the	columns	area,	and	Sales	in	the	values	area.Heres	a	GIF	to	explain	it	to
you	clearly:If	you	want,	arrange	the	values	in	decreasing	or	increasing	order.Next,	click	anywhere	on	the	Pivot	Table	as	soon	as	you	do	that,	you	will	see	a	tab	-	PivotTable	Analyze	appears	in	the	top	menu.Next,	click	on	PivotChart	inside	the	PivotTable	Analyze	menu	and	choose	the	chart	you	want	to	represent	your	data.	In	our	case,	were	choosing
Stacked	columns	from	the	chart	drop-down.The	moment	you	press	OK,	a	pivot	chart	will	appear	in	front	of	you.Volia!	You	have	made	your	first	chart.Now,	its	time	to	style	the	chart	via	formatting	options	in	Excel.Lets	start	by	giving	the	chart	a	title:Click	on	the	+	sign	that	you	see	besides	the	chart	you	just	created,	tick	the	Chart	Title	box,	and	give
your	chart	a	suitable	title.Excel	has	some	basic	formatting	options	that	you	can	use	to	make	your	chart	look	better:Chart	Title:	Change	the	title	of	your	chartLegend:	Enable,	disable,	and	edit	legend	as	neededAxes:	Edit	horizontal	axis	and	vertical	axis	of	your	chartData	Table:	Insert	a	table	that	represents	all	values	in	a	data	tableTry	them	out	and	see
how	you	want	your	pivot	chart.After	youre	done	formatting,	you	can	then	move	your	chart	to	the	Interactive	dashboard	sheet.Repeat	the	procedure	to	create	such	pivot	table	charts	for	your	interactive	dashboard,	once	youre	done,	wed	start	formatting	and	customizing	our	interactive	dashboard.When	it	comes	to	creating	charts,	Excel	gives	you	a
boatload	of	options:Bar	charts	or	column	chartsPie	chartsLine	chartsArea	chartsAnd	many	moreHeres	how	our	dashboard	looks	after	creating	3	charts.Step	#4.	Add	Interactive	Features	to	Your	Dashboard	DesignSelect	any	chart	you	want	on	your	interactive	dashboard	and	click	on	PivotChart	Analyze.	Go	ahead	and	click	on	Insert	Timeline.Note:	For
inserting	a	timeline	to	any	pivot	chart,	you	MUST	have	the	Date	column	in	your	data.Tick	the	Date	checkbox	and	press	OK.This	will	give	you	a	timeline	of	the	chart.In	a	similar	fashion	you	can	add	slicer	for	all	the	charts	you	want	to	on	the	interactive	dashboard.Heres	the	snapshot	of	our	final	interactive	dashboard	in	Excel:Doesnt	it	look	pretty?Now
that	youve	seen	how	to	create	an	interactive	dashboard	in	Excel,	its	time	to	explore	some	templates	that	you	can	use	directly.5	Free	Excel	Interactive	Dashboard	Templates#1.	Financial	DashboardA	financial	dashboard	lets	you	monitor	the	financial	performance	of	an	organization.	It	consists	of	key	financial	KPIs	such	as	net	profit,	working	capital,
accounts	receivable,	and	more.In	simple	terms,	these	dashboards	are	meant	for	executives	or	business	owners	who	arent	aware	of	financial	jargon	but	would	like	to	have	an	overview	of	all	the	financial	operations	in	theri	business.CFOs	and	finance	teams	use	these	dashboards	to	demonstrate	the	business's	financial	health	to	stakeholders	and	other
relevant	parties.Download	Link:	Financial	DashboardProduct	Revenue:	Compares	the	estimated	and	actual	revenue	generated	from	individual	products	over	the	yearRegional	Sales:	Monitors	the	region-wise	sales	of	the	company	for	the	yearSales	Rep	Performance:	Estimated	and	actual	revenue	generated	by	each	sales	rep	every	quarterProduct
Statistics:	Visualizes	the	estimated	and	actual	sales	generated	from	each	product	on	a	quarterly	basis#2.	Marketing	Performance	DashboardA	marketing	performance	dashboard	is	generally	a	one-pager	report	in	Excel	that	visualizes	key	marketing	metrics	to	gauge	progress	toward	marketing	objectives	and	goals.Modern-day	marketing	performance
dashboards	cover	two	aspects:	Offline	and	online	marketing	metrics.They	allow	you	to	collect	relevant	insights	from	your	digital	and	physical	marketing	efforts.	Thereby,	helping	you	to	target	marketing	campaigns	to	relevant	audience	groups.Download	Link:	Marketing	Performance	DashboardThis	particular	marketing	performance	dashboard	has	the
following	metrics:Budget	vs.	Spend	Per	Campaign:	Compares	the	budgeted	expenses	and	the	actual	expenses	incurred	on	individual	marketing	campaignsProfit	and	Loss	Statement:	Depicts	whether	your	marketing	efforts	are	generating	profit	or	loss	over	the	yearTotal	Impressions:	Total	number	of	times	an	ad	or	post	was	shown	in	the	user	feedCost
Per	Acquisition:	Total	cost	incurred	on	acquiring	a	new	customerClick-Through-Rate:	Measures	the	number	of	clicks	an	ad	receives	by	the	total	number	of	times	it	was	viewedRevenue	Growth:	Measures	the	percentage	growth	in	revenue	over	timeROI	from	Campaigns:	Calculates	the	monetary	value	of	an	investment	vs.	its	cost#3.	Social	Media
DashboardA	social	media	dashboard	allows	you	to	monitor	all	the	activities	going	around	your	social	media	accounts	under	one	dashboard.	The	dashboard	typically	includes	metrics	like	engagement,	traffic,	leads,	subscriber	or	follower	count,	and	audience	insights.Download	Link:	Social	Media	Dashboard	Increase	in	Followers:	Measures	the	increase
in	the	number	of	followers	on	social	profiles	over	timeTotal	Subscribers:	Accounts	for	the	number	of	users	who	subscribed	to	blogs,	newsletters,	or	YouTube	channelSales	From	Social:	Measures	the	total	revenue	generated	from	social	media	marketing	activitiesCost-Per-Click:	Evaluates	the	amount	liable	to	pay	for	each	click	on	your	ad	to	the
advertiserReturn	on	Ad	Spend	(ROAS):	Calculates	from	earnings	generated	from	running	paid	social	media	ads	and	campaigns#4.	Sales	Management	DashboardThe	dashboard	provides	an	overview	of	the	key	sales	metrics	C-level	executives	and	managers	are	keen	about.	It	includes	annual	sales,	product-wise	sales,	region-wise	sales,	and	more.
Besides,	the	dashboard	provides	granular	insights	into	the	performance	of	your	sales	team.	Like	how	your	sales	representatives	are	performing,	whether	they	are	meeting	their	targets,	and	more.Download	Link:	Sales	Management	Dashboard	This	particular	sales	management	dashboard	focuses	on	the	following:Region-Wise	Sales:	Evaluate	the	sales
made	from	specific	regions	by	individual	sales	repsOutlet-Wise	Sales:	Evaluates	sales	from	different	outlets	(store/online/phone)	made	individually	by	sales	repItem-Wise	Sales:	Calculates	revenue	generated	from	the	total	number	of	items	sold	by	individual	sales	repSales	Person	Rank:	Tracks	your	sales	team	performance	and	ranks	sale	rep	based	on
their	overall	performance	like	target	achieved,	sales	generated,	and	moreProduct-Region-Outlet	Mix:	Compiles	and	presents	a	mix	of	data	from	product,	region,	and	outlet-wise	sales	by	your	sales	team#5.	Project	Management	Dashboard	TemplateA	comprehensive	dashboard	template	that	streamlines	all	your	project-related	operations.	It	tracks	your
timeline,	budget,	task	status,	and	more.Having	this	data	readily	available	under	one	roof	can	allow	project	managers	to	manage	productivity	as	a	whole	efficiently.	Download	Link:	Project	Management	DashboardWhich	Key	Performance	Indicators	can	you	track	using	this	template?Streamline	Daily	Operations:	Use	a	Gantt	chart	to	easily	streamline
operations	and	visualize	progress	regularlyTask	Status:	Display	the	status	of	each	task	by	assigning	them	indicators	such	as	completed,	overdue,	in	progress,	or	not	started.Budget:	Compare	actual	and	planned	budgets	time-to-time	to	drive	cost-effective	strategiesPending	Items:	Curate	a	list	of	items	or	processes	that	are	pending	approvals	from	the
lead	and	visualize	them	based	on	decisions,	actions,	or	change	requestsDrawbacks	of	Creating	Dashboards	in	Excel#1.	Limited	ScalabilityExcel	struggles	with	large	amounts	of	data	and	may	become	slow	and	unresponsive.	In	some	cases,	you	can	encounter	downtime	when	multiple	users	try	to	access	a	spreadsheet	simultaneously.Both	ways,	Excel	is
not	the	first	choice	for	organizations	willing	to	scale	their	operations	from	time	to	time.Besides,	Excel	is	a	stand-alone	application.	It	does	not	integrate	with	other	platforms	or	data	sources	easily.	This	makes	it	challenging	for	companies	with	data	spread	across	multiple	social	and	analytical	platforms	to	centralize	them	under	an	Excel	sheet.#2.
Limited	Data	Visualization	OptionsWith	Excel,	you	are	limited	to	using	a	set	of	pre-built	data	visualization	elements.	Yes,	the	platform	does	offer	customization	options,	but	that	too	is	shrunk	to	basic	editing	of	charts.	Suppose	we	compare	Excel's	gallery	of	data	visualization	elements	to	Datapad	(our	tool)	or	any	modern-day	dashboard	software.	The
other	is	more	advanced	in	creating	visually	appealing	and	informative	dashboards.#3.	Lack	of	Collaboration	FeaturesExcel	doesn't	have	built-in	collaboration	features	like	Datapad.	Meaning	you	cannot	communicate	on	the	go.	You	have	to	use	a	third-party	app	for	real-time	communication.P.S.	Datapad	helps	you	eliminate	this	bottleneck.	How?	We'll
talk	about	this	feature	in	a	later	section.For	now,	Excel	has	no	control	over	what	version	of	the	application	users	work	upon	2013,	2016,	or	2019.	This	makes	it	difficult	for	users	using	a	different	version	to	experience	the	exact	same	dashboard	which	others	are	using.And	when	a	team	uses	different	versions	to	access	the	same	dashboard,	what	they
view	entirely	depends	on	what	their	version	supports.Our	POV:	You	cant	do	anything	except	circulating	a	disclaimer	to	your	team	asking	them	to	use	the	same	version.#4.	Limited	Security	OptionsExcel	does	not	have	built-in	security	options,	making	it	easy	for	unauthorized	users	to	access	and	modify	data.	This	can	often	lead	to	data	manipulation	and
inaccurate	results.	#5.	Limited	AutomationBeing	from	a	90's	background,	Excel	comes	with	next-to-no	automation.	In	fact,	its	users	spend	most	of	their	time	preparing	data	and	double-checking	it	manually.	Simply	put,	Excel	does	not	have	the	ability	to	automate	the	process	of	data	collection	and	updating.	This	leads	to	a	lot	of	manual	work,	thereby
increasing	the	chances	of	human	errors	or	unintentional	data	manipulation.Create	Stunning	Interactive	Dashboards	with	DatapadDatapad	is	the	industry's	leading	mobile-only	platform	that	allows	you	to	create	dynamic	interactive	dashboards	and	makes	data	analysis	easy	for	you	and	your	team.We've	ensured	to	fit	in	all	the	crucial	features	of
creating	a	dashboard	into	a	powerful	mobile	app	(don't	worry,	it	doesn't	consume	much	space).Moreover,	we	have	fully	automated	the	process	of	creating	interactive	dashboards,	from	data	extraction	to	cleansing	and	presenting;	you	can	do	it	all	in	a	matter	of	minutes,	provided	you	have	a	stable	internet	connection.Moving	forward,	we'll	show	how
our	tool	can	help	you	create	a	stunning	dashboard	in	easy-to-do	steps.	And	then,	as	we	said	earlier,	we'll	discover	some	cool	features	of	Datapad,	like	built-in	chat	features.Step	#1.	Register	on	DatapadGet	your	hands	on	our	mobile	app.	You	can	easily	download	it	from	the	app	store	or	play	store.	Once	into	the	app,	signup	with	your	preferred	email
address.	Note:	Please	provide	an	active	email	to	receive	verification	mail	and	other	updates	from	our	team.Soon	after,	you'll	be	prompted	to	create	your	personal	workspace.	A	workplace	is	your	personal	office	where	you	can	store	all	your	data	and	dashboards,	create	new	dashboards,	and	have	complete	control	over	access.So,	give	a	name	to	your
space	and	press	Create	Workspace.Step	#2.	Create	a	DashboardNext,	click	on	the	(+)	sign	in	the	top	right	corner	to	create	a	new	dashboard.	In	this	dashboard,	you'll	have	all	your	charts	under	one	roof.Give	your	dashboard	name,	description,	and	an	emoji	(optional)	and	hit	the	create	button	on	the	top	right	corner.Step	#3.	Import	DataTo	import	data
to	the	dashboard,	tap	on	Options	at	the	top	right	corner.Then	click	on	Add	Metric.	You	can	manually	enter	data	or	import	it	automatically	using	our	one-click	integrations	to	popular	marketing	platforms.To	automatically	import	data:Click	on	Use	Data	SourceChoose	from	our	existing	list	of	integrationsPress	Add	and	your	data	is	automatically	imported
into	your	chart.Here's	the	process	in	action.Step	#4.	Invite	Team	MembersFrom	your	workplace,	click	on	the	Datapad	icon	>	Manage	Users.	Next,	click	on	(+)	in	the	top	right	corner.Enter	email	addresses	to	send	invite	emails	to	as	many	people	as	you	want	onboard.Step	#5.	Customize	the	DashboardAnd	finally,	you're	all	set	to	change	the	look	and
feel	of	your	dashboard.Datapad	offers	plenty	of	customization	options.	You	have	a	choice	to	set	your	chart	type,	change	colors,	font	styles	and	size,	and	more.Besides,	our	intuitive	drag-and-drop	feature	allows	you	to	perform	granular	customizations	hassle-free.And	when	you're	happy	with	the	look,	you	know	you	have	the	dashboard	ready	to	be
shared.For	the	most	part,	we	cherish	these	key	features	of	our	tool.Key	Feature	#1.	Mobile-FriendlinessWith	Datapad,	you	eliminate	the	hustle	of	scrolling	through	lengthy	sheets	and	big	data	graphs.Our	mobile-first	interface	allows	you	to	work	and	navigate	seamlessly	across	the	app.Besides,	we	tested	Datapad	for	compatibility	and	resolution	on	all
small-screen	devices.	And	guess	the	results?It's	pixel-perfect	for	all.	Key	Feature	#2.	Ease	of	Data	ImportDo	you	remember	how	importing	data	to	Excel	is	a	nightmare?	Well!	We	got	a	cure.Datapad	allows	you	to	import	data	both	ways:	automatically	and	manually.Earlier,	we	explained	how	to	import	data	via	our	one-click	integrations.	Here,	you'll	see
how	to	do	the	process	manually.Click	on	Add	Metric	>	Enter	ManuallyInsert	ValuesChoose	a	chart	typeAnd	you're	done.	Need	help	with	the	process?No	worries;	we	always	have	a	demo	for	you.	Key	Feature	#3.	Team	CollaborationDatapad	offers	an	in-built	chat	feature	that	makes	team	collaborations	a	piece	of	cake.In	Datapad,	you	can	simply
comment	under	a	chart	or	metric	to	strike	up	a	conversation	with	your	teammates	in	real-time.	For	example,	if	you	see	something	off	with	a	metric,	here's	what	you	can	do:	Comment	your	views	right	below	the	metric	Your	team	gets	real-time	alerts	or	push	notifications	of	your	comment	They	reply	under	your	comment	(and	then	the	conversion	can	go
on)Simply	put,	it	works	similarly	to	Twitter	threads.Here's	the	feature	in	actionKey	Feature	#4.	Data	SecurityUnlike	Excel,	you	can	enable	role-based	management	in	Datapad.	It	will	allow	you	to	control	who	can	view/access/edit	the	dashboard.Moreover,	you	can	see	user	activities	in	history	or	in	real	time	to	be	informed	about	who's	active	on	the
dashboard.Astonished	to	go-through	so	many	features	for	a	free	dashboarding	tool?	Why	dont	you	try	it	yourself	to	create	interactive	and	dynamic	dashboards,	and	test	our	tool	for	real!Experience	Datapads	magic	todayno	installation	required.	Start	your	free	7-day	trial	instantly,	or	book	a	demo	to	see	it	in	action!Creating	an	interactive	Excel
spreadsheet	might	sound	a	bit	like	sorcery	at	first,	but	trust	me,	it's	more	about	adding	a	dash	of	magic	to	the	mundane.	Imagine	turning	your	static	data	into	a	dynamic,	user-friendly	tool	that	not	only	looks	impressive	but	also	makes	data	manipulation	a	breeze.	We'll	walk	through	the	steps	to	transform	your	Excel	spreadsheet	into	an	interactive
masterpiece.	From	using	drop-down	lists	to	adding	conditional	formatting,	I'll	guide	you	on	how	to	make	your	data	not	just	informative	but	also	engaging	and	easy	to	use.	So,	let's	roll	up	our	sleeves	and	get	started!Build	dashboards	&	reports	in	seconds	with	the	best	AI	spreadsheet.	Bricks	makes	creating	dashboards,	reports,	and	charts	a	breeze.	Try
it	free	Before	jumping	into	the	technical	aspects,	it's	important	to	understand	why	you	want	to	make	your	spreadsheet	interactive.	Is	it	to	simplify	data	entry	for	your	team?	Or	perhaps	to	create	a	dashboard	that	reflects	real-time	numbers?	Defining	your	objective	will	help	you	decide	which	features	to	incorporate.	For	instance,	if	your	goal	is	to
facilitate	data	entry,	you	might	want	to	consider	using	data	validation	techniques	like	drop-down	menus	or	checkboxes.	These	elements	can	reduce	errors	and	make	the	spreadsheet	more	intuitive.	On	the	other	hand,	if	you're	creating	a	dashboard,	features	like	pivot	tables	and	charts	will	be	your	best	friends.	Remember,	the	clearer	your	goals,	the
easier	it	will	be	to	select	the	right	tools	and	techniques.	So,	take	a	moment	to	jot	down	what	you	hope	to	achieve	with	your	interactive	spreadsheet.	Now	that	you	know	what	you	want	your	spreadsheet	to	do,	it's	time	to	think	about	layout.	A	well-organized	spreadsheet	is	like	a	road	map	for	users.	They	should	be	able	to	navigate	it	without	needing	a
GPS!	Start	by	sketching	out	a	rough	design	on	paper	or	using	a	tool	like	PowerPoint.	Visualize	where	each	elementlike	data	tables,	charts,	or	buttonswill	go.	This	planning	stage	will	save	you	a	lot	of	headaches	later	on.	Consider	using	separate	sheets	for	raw	data	and	results.	This	keeps	things	tidy	and	ensures	users	wont	accidentally	mess	up	your
formulas.	Use	cell	colors	sparingly	to	highlight	important	areas,	but	avoid	turning	your	spreadsheet	into	a	rainbow.	Incorporate	clear	labels	and	instructions	within	the	sheet.	You	can	use	comments	or	text	boxes	to	explain	complex	sections.	User	guidance	is	crucial,	especially	if	others	will	be	using	your	spreadsheet	without	your	supervision.Bricks	is
an	AI-first	spreadsheet	that	makes	creating	dashboards,	reports,	and	analyzing	your	data	a	breeze.	Import	your	data,	describe	what	you	want,	and	improve	it	by	asking	for	changes.GET	STARTED	FOR	FREE	Drop-down	lists	are	a	nifty	way	to	control	data	entry	and	maintain	consistency.	They	make	it	easier	for	users	to	select	options	without	worrying
about	typing	errors.	Let's	see	how	you	can	create	one:	First,	decide	where	the	drop-down	will	be.	Click	on	the	cell	where	you	want	it.	Go	to	the	Data	tab	in	Excel's	ribbon,	and	click	Data	Validation.	In	the	Data	Validation	dialog	box,	choose	List	from	the	Allow	drop-down	menu.	In	the	Source	field,	either	type	your	options	separated	by	commas	or	select
a	list	of	items	from	your	spreadsheet.	And	there	you	have	it!	A	simple	drop-down	list	that	can	save	a	ton	of	time	and	reduce	mistakes.	This	is	especially	useful	if	you're	dealing	with	repetitive	data,	like	product	categories	or	employee	roles.	Conditional	formatting	is	like	giving	your	spreadsheet	a	pair	of	glassesit	helps	you	see	patterns	and	trends	at	a
glance.	Want	to	highlight	sales	numbers	over	a	certain	threshold	or	mark	overdue	tasks?	Conditional	formatting	has	got	you	covered.	To	set	it	up:	Select	the	range	of	cells	you	want	to	format.	Click	on	Conditional	Formatting	in	the	Home	tab.	Choose	a	rule	type.	For	example,	you	might	use	Highlight	Cell	Rules	to	mark	cells	with	values	greater	than	a
certain	number.	Customize	the	rule	to	fit	your	needs,	then	click	OK.	This	feature	not	only	makes	important	data	stand	out	but	also	enhances	the	visual	appeal	of	your	spreadsheet.	It's	like	adding	a	splash	of	color	to	an	otherwise	monochrome	canvas.	Charts	can	transform	dull	numbers	into	a	compelling	story.	Interactive	charts	take	it	a	step	further	by
allowing	users	to	explore	the	data	in	more	depth.	Excel	offers	several	options	for	dynamic	charts,	like	slicers	and	timeline	filters.	Here's	how	to	get	started:	Select	your	data	range	and	go	to	the	Insert	tab.	Choose	the	type	of	chart	that	best	represents	your	data.	Bar,	line,	and	pie	charts	are	classic	options.	To	add	interactivity,	use	Slicers	or	Timeline.
These	tools	let	users	filter	data	with	just	a	click.	Interactive	charts	are	perfect	for	dashboards	or	presentations	where	users	need	to	drill	down	into	specific	datasets.	They	make	data	exploration	intuitive	and	engaging.	Buttons	paired	with	macros	can	automate	repetitive	tasks,	saving	time	and	reducing	errors.	Imagine	having	a	button	that	refreshes
your	data	or	generates	a	report	with	a	single	click.	Setting	up	a	button	with	a	macro	involves	a	few	steps:	Go	to	the	Developer	tab	(you	might	need	to	enable	this	under	Excel	Options).	Click	Insert	and	choose	Button	from	the	form	controls.	Draw	your	button	on	the	spreadsheet,	which	will	prompt	you	to	assign	a	macro.	If	you	already	have	a	macro,
select	it;	otherwise,	you'll	need	to	record	a	new	one.	Macros	can	be	a	bit	daunting	at	first,	especially	if	you're	not	familiar	with	VBA	(Visual	Basic	for	Applications).	But	don't	worry,	Excel's	macro	recorder	can	handle	most	tasks	without	needing	to	write	a	single	line	of	code.	If	you're	dealing	with	large	datasets,	pivot	tables	are	your	best	friend.	They
allow	users	to	summarize,	analyze,	and	explore	data	easily.	With	a	few	clicks,	you	can	create	reports	that	would	otherwise	take	hours	to	compile.	Here's	a	quick	guide	to	setting	up	a	pivot	table:	Select	your	data	range,	including	headers.	Go	to	the	Insert	tab	and	click	Pivot	Table.	Choose	where	you	want	the	pivot	table	to	be	placedeither	in	a	new
worksheet	or	an	existing	one.	Drag	fields	to	the	Rows,	Columns,	and	Values	areas	to	build	your	report.	Pivot	tables	are	incredibly	flexible	and	can	be	adjusted	on	the	fly.	They	enable	users	to	slice	and	dice	data,	providing	insights	that	static	tables	can't	offer.	Once	your	interactive	spreadsheet	is	set	up,	you'll	want	to	protect	your	hard	work.	Protecting
your	spreadsheet	ensures	users	can	interact	with	it	as	intended	without	accidentally	altering	formulas	or	essential	data.	To	protect	your	spreadsheet:	Go	to	the	Review	tab	and	click	Protect	Sheet.	Choose	which	actions	you	want	to	allow,	such	as	selecting	unlocked	cells	or	formatting	rows.	Set	a	password	to	prevent	unauthorized	changes.	While	it's
important	to	protect	your	work,	make	sure	you	leave	enough	flexibility	for	users	to	interact	with	the	spreadsheet	as	needed.Bricks	makes	it	easy	to	analyze	data,	create	dashboards	and	reports,	and	get	insights	from	your	spreadsheet	data.SIGN	UP	for	free	Before	rolling	out	your	interactive	spreadsheet	to	a	wider	audience,	it's	crucial	to	test	it
thoroughly.	Use	it	yourself	to	see	if	it	behaves	as	expected.	Run	through	common	tasks	and	ask	yourself	if	the	spreadsheet	makes	those	tasks	easier.	Once	you're	satisfied	with	your	testing,	share	the	spreadsheet	with	a	few	colleagues	or	friends	for	feedback.	Ask	them	to	use	it	and	report	back	on	their	experience.	Did	they	find	it	intuitive?	Did	they
encounter	any	issues?	Their	insights	can	be	invaluable.	Iterate	based	on	the	feedback	you	receive.	Sometimes	small	tweaks	can	make	a	big	difference	in	user	experience.	Remember,	an	interactive	spreadsheet	should	make	life	easier	for	its	usersnot	more	complicated.	We've	covered	a	lot	of	ground	today,	from	setting	clear	objectives	and	designing
layouts	to	adding	interactive	elements	like	charts	and	macros.	Creating	an	interactive	Excel	spreadsheet	is	all	about	making	data	more	accessible	and	engaging,	transforming	numbers	into	a	narrative	that	anyone	can	follow.	For	those	looking	to	take	their	spreadsheets	to	the	next	level,	Bricks	offers	an	incredible	solution.	By	integrating	spreadsheets,
docs,	and	presentations,	Bricks	brings	AI	to	the	table,	allowing	you	to	automate	tasks	like	writing	formulas,	cleaning	data,	and	generating	visuals	from	your	spreadsheet	data.	Whether	you're	crafting	dashboards,	reports,	or	project	trackers,	Bricks	can	handle	it	all	in	seconds,	making	the	spreadsheet	expert	in	you	breathe	a	little	easier.header-1-
2header-2-2header-1-4header-2-4header-3-4header-4-4header-1-6header-2-6header-1-8header-2-8Bricks	is	the	AI-first	dashboard	and	reporting	tool	for	spreadsheet	data.	Create	charts,	graphs,	and	analyze	your	data	in	seconds	-	no	data	analyst	needed.Create	your	first	report	In	today's	digital	age,	interactive	excel	spreadsheets	are	crucial	for
businesses	and	individuals	alike.	They	allow	for	data	manipulation,	analysis,	and	visualization,	making	it	easier	to	understand	and	interpret	complex	information.	In	this	tutorial,	we	will	cover	the	basics	of	creating	an	interactive	excel	spreadsheet,	including	data	validation,	conditional	formatting,	and	interactive	charts.	By	the	end	of	this	tutorial,	you
will	have	the	skills	to	create	your	own	dynamic	and	engaging	excel	spreadsheets.Key	Takeaways	Interactive	excel	spreadsheets	are	essential	for	data	manipulation,	analysis,	and	visualization.	Basic	Excel	functions,	formulas,	and	cell	formatting	are	foundational	for	creating	interactive	spreadsheets.	Data	validation,	drop-down	menus,	and	checkboxes
are	valuable	tools	for	creating	interactive	elements.	Hyperlinks,	macros,	and	user-friendly	design	elements	enhance	the	interactivity	of	excel	spreadsheets.	Creating	interactive	excel	spreadsheets	benefits	businesses	and	individuals	by	making	data	more	engaging	and	accessible.Understanding	the	basics	of	Excel	Excel	is	a	powerful	tool	that	allows
users	to	organize	and	analyze	data	in	a	structured	manner.	Understanding	the	basics	of	Excel	is	essential	for	creating	an	interactive	spreadsheet.	A.	Explanation	of	Excel	interface	and	basic	functionsWhen	you	open	Excel,	you	will	see	a	grid	of	cells	arranged	in	rows	and	columns.	This	is	where	you	will	input	your	data	and	perform	calculations.	The
interface	includes	tabs	such	as	Home,	Insert,	Page	Layout,	Formulas,	Data,	Review,	and	View,	each	offering	different	functions	to	manipulate	your	spreadsheet.	B.	How	to	input	data	and	format	cellsTo	input	data	into	a	cell,	simply	click	on	the	desired	cell	and	start	typing.	You	can	format	cells	by	changing	the	font,	number	format,	alignment,	and	more.
This	helps	to	make	your	spreadsheet	visually	appealing	and	easy	to	read.	C.	Introduction	to	formulas	and	functionsIn	Excel,	formulas	are	used	to	perform	calculations	on	data	in	your	spreadsheet.	Functions	are	predefined	formulas	that	can	help	you	perform	specific	calculations.	Some	common	functions	include	SUM,	AVERAGE,	MAX,	MIN,	and
COUNT.Creating	interactive	elements	Interactive	elements	in	an	Excel	spreadsheet	can	greatly	enhance	its	usability	and	functionality.	Here	are	some	ways	to	make	your	spreadsheet	more	interactive.	A.	Adding	drop-down	menus	for	easy	data	inputStep	1:	Select	the	cell	or	cells	where	you	want	to	add	the	drop-down	menu.	Step	2:	Go	to	the	"Data"	tab
and	click	on	"Data	Validation."	Step	3:	In	the	Data	Validation	dialog	box,	choose	"List"	from	the	Allow	drop-down	menu.	Step	4:	In	the	Source	box,	enter	the	options	you	want	to	appear	in	the	drop-down	menu,	separated	by	commas.	B.	Using	checkboxes	for	selection	optionsStep	1:	Go	to	the	"Developer"	tab,	and	click	on	"Insert"	in	the	Controls	group.
Step	2:	In	the	Form	Controls	section,	click	on	the	checkbox	icon.	Step	3:	Click	and	drag	to	draw	a	checkbox	in	the	desired	location	on	the	spreadsheet.	C.	Incorporating	buttons	for	navigation	or	calculationsStep	1:	Go	to	the	"Developer"	tab,	and	click	on	"Insert"	in	the	Controls	group.	Step	2:	In	the	ActiveX	Controls	section,	click	on	the	button	icon.
Step	3:	Click	and	drag	to	draw	a	button	in	the	desired	location	on	the	spreadsheet.	Step	4:	Right-click	on	the	button	and	select	"Assign	Macro"	to	link	the	button	to	a	specific	function	or	calculation.Utilizing	data	validation	Excel	offers	a	powerful	feature	called	data	validation	that	allows	you	to	control	the	type	and	format	of	data	that	can	be	entered
into	a	cell.	This	can	be	extremely	useful	for	creating	an	interactive	and	error-free	excel	spreadsheet.	Setting	up	rules	for	data	inputOpen	Excel:	Start	by	opening	the	Excel	spreadsheet	where	you	want	to	apply	data	validation.	Select	the	cell:	Select	the	cell	or	range	of	cells	where	you	want	to	apply	the	data	validation.	Go	to	Data	tab:	Next,	go	to	the
Data	tab	on	the	Excel	ribbon.	Click	on	Data	Validation:	In	the	Data	Tools	group,	click	on	the	Data	Validation	option.	Set	the	criteria:	In	the	Data	Validation	dialog	box,	choose	the	type	of	data	validation	you	want	to	apply,	such	as	whole	numbers,	decimals,	date,	time,	text	length,	etc.	Set	the	criteria	for	the	data	input.	Save	the	settings:	Click	OK	to	save
the	data	validation	settings.	Creating	custom	error	messagesOpen	Data	Validation	dialog	box:	To	create	custom	error	messages,	go	to	Data	Validation	dialog	box	as	mentioned	above.	Switch	to	Error	Alert	tab:	In	the	Data	Validation	dialog	box,	switch	to	the	Error	Alert	tab.	Customize	the	error	message:	Here,	you	can	customize	the	title	and	error
message	that	will	appear	when	the	user	enters	invalid	data.	You	can	provide	clear	instructions	on	the	type	of	data	that	should	be	entered.	Save	the	settings:	Once	you	have	customized	the	error	message,	click	OK	to	save	the	settings.	Using	data	validation	for	data	integrity	and	accuracyPrevent	invalid	data	entry:	By	setting	up	rules	for	data	input	and
creating	custom	error	messages,	you	can	prevent	users	from	entering	invalid	or	incorrect	data	into	the	spreadsheet,	thus	ensuring	data	integrity	and	accuracy.	Improve	user	experience:	Data	validation	can	improve	the	overall	user	experience	by	guiding	users	to	enter	the	right	type	of	data	and	providing	helpful	error	messages	in	case	of	mistakes.
Reduce	errors:	With	data	validation	in	place,	you	can	significantly	reduce	the	chances	of	errors	in	your	spreadsheet,	leading	to	more	reliable	and	trustworthy	data.Using	hyperlinks	and	macros	In	this	chapter,	we	will	explore	the	use	of	hyperlinks	and	macros	to	make	your	Excel	spreadsheet	more	interactive	and	user-friendly.	By	incorporating	these
features,	you	can	enhance	the	functionality	of	your	spreadsheet	and	make	data	navigation	and	manipulation	more	efficient.	A.	Linking	cells	to	other	sheets	or	external	sources	One	way	to	make	your	Excel	spreadsheet	interactive	is	by	linking	cells	to	other	sheets	within	the	same	workbook	or	to	external	sources	such	as	websites	or	other	documents.
This	can	be	particularly	useful	for	creating	a	navigation	system	within	your	spreadsheet	or	for	providing	additional	context	or	reference	material.	Internal	linking:	To	link	cells	to	other	sheets	within	the	same	workbook,	simply	select	the	cell,	right-click,	and	choose	"Hyperlink."	Then,	select	the	sheet	you	want	to	link	to	from	the	"Place	in	this
Document"	list.	External	linking:	To	link	cells	to	external	sources,	follow	the	same	process	but	choose	"Existing	File	or	Web	Page"	and	enter	the	URL	or	file	path.	B.	Introduction	to	basic	macro	creation	Macros	are	a	powerful	tool	in	Excel	that	allow	you	to	automate	repetitive	tasks	and	add	interactivity	to	your	spreadsheets.	By	recording	a	series	of
actions,	you	can	create	a	macro	that	can	be	triggered	with	a	single	click,	saving	time	and	reducing	the	risk	of	errors.	Recording	a	basic	macro:	To	create	a	basic	macro,	go	to	the	"Developer"	tab,	click	"Record	Macro,"	and	then	perform	the	actions	you	want	to	record.	Once	you're	done,	click	"Stop	Recording"	and	give	your	macro	a	name	and	shortcut
key.	C.	Incorporating	macros	for	automation	and	interactivity	Once	you	have	a	basic	understanding	of	macro	creation,	you	can	incorporate	them	into	your	spreadsheet	to	automate	repetitive	tasks	and	add	interactivity.	This	can	include	anything	from	automatically	formatting	data	to	creating	interactive	buttons	for	navigation.	Assigning	macros	to
buttons:	To	make	your	spreadsheet	more	interactive,	you	can	assign	macros	to	buttons	that	users	can	click	to	trigger	specific	actions.	This	can	be	particularly	useful	for	creating	custom	navigation	or	data	manipulation	tools.	Creating	interactive	forms:	Another	way	to	incorporate	macros	for	interactivity	is	by	creating	custom	forms	that	allow	users	to
input	data	and	trigger	specific	actions	based	on	their	inputs.	This	can	be	a	powerful	way	to	streamline	data	entry	and	manipulation.Making	the	spreadsheet	user-friendly	Creating	an	interactive	excel	spreadsheet	involves	more	than	just	inputting	data	and	formulas.	In	order	to	make	it	user-friendly,	you	need	to	consider	how	your	audience	will	interact
with	the	spreadsheet	and	make	it	easy	for	them	to	understand	and	navigate.	A.	Organizing	data	for	easy	understanding	Organize	your	data	into	logical	groups	and	categories	to	make	it	easier	for	users	to	find	what	they're	looking	for.	This	can	be	done	by	using	color-coding,	filters,	or	grouping	rows	and	columns.	Use	clear	and	descriptive	headers	for
each	section	of	the	spreadsheet.	This	helps	users	quickly	identify	the	purpose	of	each	section	and	find	the	information	they	need.	Instead	of	referencing	cells	by	their	coordinates,	use	named	ranges	to	make	formulas	and	references	more	intuitive	and	easier	to	understand.	B.	Using	conditional	formatting	for	visual	cues	Use	conditional	formatting	to
automatically	highlight	cells	that	meet	certain	criteria,	such	as	values	above	or	below	a	certain	threshold.	This	helps	draw	attention	to	important	data.	Assign	different	colors	to	cells	based	on	their	content	or	meaning.	For	example,	use	green	for	"good"	and	red	for	"bad"	to	quickly	convey	the	status	of	certain	data	points.	C.	Adding	instructions	or
guides	for	users	Add	comments	to	cells	to	provide	additional	context	or	instructions	for	users.	This	can	be	especially	helpful	for	complex	formulas	or	data	that	require	explanation.	If	the	spreadsheet	is	complex	or	contains	multiple	sections,	consider	creating	a	separate	guide	sheet	that	explains	the	purpose	of	each	section,	how	to	navigate	the
spreadsheet,	and	any	other	relevant	information.	ConclusionIn	summary,	this	tutorial	has	covered	the	key	steps	to	creating	an	interactive	Excel	spreadsheet,	including	using	data	validation,	conditional	formatting,	and	creating	drop-down	lists.	The	benefits	of	creating	interactive	Excel	spreadsheets	are	numerous,	including	improved	data	organization,
increased	user	engagement,	and	enhanced	visual	appeal.	I	encourage	you	to	continue	exploring	and	practicing	with	Excel's	interactive	features,	as	they	can	greatly	enhance	your	work	and	make	your	spreadsheets	more	dynamic	and	user-friendly.	As	a	small	business	owner,	you	will	often	have	to	work	with	others	on	an	Excel	worksheet.	For	example,	if
you	have	hired	a	sales	or	marketing	consultant,	you	can	give	them	an	interactive	worksheet	for	sales	projections	or	expense	reports.	An	interactive	worksheet	allows	users	to	enter	data	in	specific	cells,	giving	them	instructions	as	to	what	type	of	data	is	required	in	each	cell	and	error	messages	if	they	enter	the	wrong	data.	You	can	also	hide	and
protect	formulas	in	the	worksheet	to	prevent	them	from	being	accidentally	modified	or	deleted	by	the	user.Article	continues	below	this	adArticle	continues	below	this	ad	Creating	a	live	Excel	sheet	is	like	building	a	magic	spreadsheet	that	updates	automatically.	Whether	youre	tracking	sales	data,	monitoring	project	progress,	or	collaborating	in	real-
time,	a	live	Excel	sheet	keeps	everyone	on	the	same	page.	In	this	guide,	well	walk	through	the	steps	to	set	it	up,	offer	tips	for	smooth	operation,	address	common	questions,	and	summarize	the	process.How	to	Make	a	Live	Excel	SheetImagine	youre	setting	up	a	live	Excel	sheet	to	update	and	share	data	in	real-time.	This	tutorial	will	guide	you	through
connecting	your	Excel	sheet	to	an	online	platform,	sharing	it	with	others,	and	ensuring	it	updates	automatically.Step	1:	Open	Excel	and	Create	Your	SpreadsheetFirst,	open	Excel	and	create	a	new	spreadsheet	by	clicking	New	and	selecting	Blank	Workbook.Its	essential	to	have	a	clear	idea	of	the	data	you	need	to	track.	Whether	its	inventory,	budgets,
or	schedules,	set	up	your	columns	and	rows	so	that	the	information	is	easy	to	input	and	read.Step	2:	Save	Your	Workbook	to	OneDriveNext,	save	your	workbook	to	OneDrive	by	clicking	File,	then	Save	As,	and	choosing	OneDrive	as	the	location.Saving	your	Excel	sheet	to	OneDrive	makes	it	accessible	from	anywhere	with	an	internet	connection.	This
step	is	crucial	because	it	allows	you	to	share	the	workbook	and	collaborate	with	others.Step	3:	Share	Your	WorkbookClick	File,	then	Share,	and	choose	Share	with	People.	Enter	the	email	addresses	of	the	people	you	want	to	collaborate	with	and	set	their	permissions.Sharing	your	workbook	with	others	allows	multiple	users	to	view	and	edit	the
document	simultaneously.	You	can	control	who	has	edit	access	and	who	can	only	view	the	data.Step	4:	Enable	AutoSaveMake	sure	AutoSave	is	turned	on.	You	can	find	this	by	checking	the	top-left	corner	of	the	Excel	window.AutoSave	ensures	that	any	changes	made	to	the	workbook	are	saved	automatically.	This	feature	is	a	lifesaver,	preventing	data
loss	and	keeping	everyones	updates	current.Step	5:	Use	Excel	Online	for	Real-Time	CollaborationIf	your	collaborators	dont	have	Excel	installed,	they	can	use	Excel	Online.	Send	them	a	link,	and	they	can	work	on	the	sheet	in	their	browser.Excel	Online	is	a	powerful	tool	for	real-time	collaboration.	It	allows	everyone	to	see	updates	instantly,	without
needing	to	install	any	software.Once	youve	completed	these	steps,	your	Excel	sheet	will	be	live,	automatically	updating	with	each	change	made	by	users.	This	setup	is	perfect	for	keeping	your	team	on	the	same	page	without	the	hassle	of	sending	multiple	versions	back	and	forth.Tips	for	Making	a	Live	Excel	SheetUse	clear	and	descriptive	column
headers	to	make	data	entry	straightforward.Regularly	check	the	shared	settings	to	ensure	the	right	people	have	access.Keep	your	workbook	organized	to	avoid	confusion	among	collaborators.Use	data	validation	to	prevent	incorrect	data	entry.Set	up	notifications	for	any	changes	made	to	critical	data.Frequently	Asked	QuestionsWhat	happens	if
someone	makes	a	mistake	in	the	live	Excel	sheet?If	someone	makes	a	mistake,	you	can	use	the	version	history	feature	in	Excel	to	revert	to	a	previous	version	of	the	sheet.Can	I	set	different	permissions	for	different	users?Yes,	you	can	set	different	permissions	for	each	user	when	you	share	the	workbook.	Some	can	have	editing	rights,	while	others	may
only	view.How	many	people	can	collaborate	on	a	live	Excel	sheet	simultaneously?Excel	supports	multiple	users	working	on	the	same	sheet	simultaneously,	but	performance	may	vary	based	on	the	number	of	collaborators	and	the	complexity	of	the	data.Do	all	collaborators	need	an	Office	365	subscription?No,	collaborators	can	use	Excel	Online	for	free.
However,	some	advanced	features	might	require	an	Office	365	subscription.How	do	I	know	who	made	changes	to	the	live	Excel	sheet?The	activity	feed	in	Excel	shows	who	made	recent	changes	to	the	document,	helping	you	track	edits	and	updates.SummaryOpen	Excel	and	create	your	spreadsheet.Save	your	workbook	to	OneDrive.Share	your
workbook.Enable	AutoSave.Use	Excel	Online	for	real-time	collaboration.ConclusionMaking	a	live	Excel	sheet	is	an	excellent	way	to	streamline	your	data	management	and	collaboration	efforts.	By	following	the	steps	outlined	in	this	guide,	you	can	ensure	your	data	stays	up-to-date	and	accessible	to	everyone	who	needs	it.	Remember	to	use	the	tips
provided	to	keep	your	sheet	organized	and	error-free.Setting	up	a	live	Excel	sheet	isnt	just	about	keeping	data	current;	its	about	fostering	a	collaborative	environment	where	everyone	can	contribute	and	stay	informed.	Dont	let	the	process	intimidate	youtake	it	step-by-step,	and	soon	enough,	youll	have	a	live	Excel	sheet	that	meets	your	needs
perfectly.	For	further	reading,	check	out	additional	resources	on	Excels	collaboration	features.	Ready	to	get	started?	Dive	in	and	watch	how	a	live	Excel	sheet	can	transform	your	workflow!Matt	Jacobs	has	been	working	as	an	IT	consultant	for	small	businesses	since	receiving	his	Masters	degree	in	2003.	While	he	still	does	some	consulting	work,	his
primary	focus	now	is	on	creating	technology	support	content	for	SupportYourTech.com.His	work	can	be	found	on	many	websites	and	focuses	on	topics	such	as	Microsoft	Office,	Apple	devices,	Android	devices,	Photoshop,	and	more.	
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